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Executive Summary
The Proflex system supports a manager’s work on flexible, usually multi-person, projects
whose activities frequently change over the project lifetime. Proflex allows creation,
configuration, execution and monitoring of activities within a project. Activities may be
defined at various levels providing a hierarchic structure.
The Proflex User Documentation provides general information on how to use Proflex
(Version 1.3).
The documentation is provided in two manuals:
• Reference Manual
A description of the major components of the Proflex system and a guide
to the functions and features available.
• Users’ Guide (this document)
An introduction to the use of the Proflex system which uses scenarios to
walk the reader through the facilities available. This guide can be used
with a running system in order to provide an introductory tutorial.
Both Users’ Guide and Reference Manual are intended to be read by all Proflex Users and
also by the Proflex System Administrators.
A copy of the Proflex Glossary is included with each manual to assist the reader.
The reader is expected to possess a basic knowledge of using a window system and be
used to using Outlook.
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1. INTRODUCTION
This document is the Users’ Guide to the Proflex system. It provides a scenario oriented
overview of the usage of the Proflex System, version 1.3. This means there is a worked
example, comprising several scenarios, which can be followed using the Proflex system.
As many features as possible are introduced as the example progresses so that by the end
the user will have seen and used the main functions within Proflex. The example begins a
new project and defines new activities which are configured and sent out for working.
The example creates a new project and gives it a name. An activity is created and configured
by providing a description, setting an actor and providing instructions for the activity. The
activity is then sent out for action. The focus of the example then moves to the Inbox of the
actor and the activity, newly received, is read and completed. The changed state of the
activity is seen in the Proflex Manager where further activities and sub-activities are added.
Once work is finished on the one project it is closed away and another project is loaded.
 Each action in the example is labelled as this sentence shows. That is, what you should
do in order to work through the example.
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2. STARTING THE PROFLEX MANAGER
Be sure that you have installed Outlook 98 and the Proflex components correctly
corresponding to the Installation Guide. Make sure that the Background Agent is started and
the timer is running (see appropriate section in Reference Manual or the Installation Guide
for more information about the agent). The Background Agent is necessary in order to see
the activities being sent between the Proflex Manager (PM) and the Inboxes.
 Start the Proflex Manager by clicking on the executable ProflexManager.exe.
This executable may be installed on your desktop or you may need to find it using Windows
Explorer. Please refer to your Proflex System Administrator if you cannot find the .exe.
See the Reference Manual for more information about configuring the PM and starting it.
A splash screen is displayed as shown in Figure 1.

Figure 1: The Proflex Splashscreen
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The PM main window is displayed as shown in Figure 2. Under the title bar is the main menu
bar, containing items Project, Skeleton, Edit etc. Those menus which have usable items are

Figure 2: PM main window
the only active ones. For example Activity is not active, as there are no activities at present.
Beneath the main menu bar is the toolbar, which contains buttons labelled with icons. You
should notice that only two of the toolbar buttons are live (usable). These are the new project
button and the open project button.
The large area within the window is the display area for the views of a project, once a project
is loaded. At the bottom of the window is a status bar which displays useful messages as to
what the system is doing or whether it is ready for the next request.
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3. CREATING AND NAMING A NEW PROJECT
 Click the ‘New Project’ button
in the toolbar and wait whilst Proflex creates a new
project and then displays it in the Proflex Manager.
The status bar at the bottom left of the window displays useful messages whilst the Proflex
Manager is working and a busy cursor is seen.

Figure 3: A new project
Once the project has been created, as shown in Figure 3, the 'Activity' menu becomes active
(usable) in the main menu bar and the display area shows the views of the newly created
project.
With each new project a name needs to be set. This is done in the Name field highlighted
within the tree view, which is the name given to the left-most panel within the Proflex
Manager. The central panel is known as the list view and the right-most panel is known as
the graphic view. The use of these different views will be introduced in due course. Basically
the tree view is used to see the hierarchical structure of the project; the list view is used to
see all the activities and their current state and the graphical view is a spatial view, showing
the activities and their hierarchy and their state. [A full description can be found in the
Proflex V1.3 Reference Manual.]
 Type your new Project name. We have used “PM Usage” for this example.
 As the default name was highlighted it is overwritten.
When you move out of the name field, select something else in the window using the mouse
or keyboard the name change is confirmed. If your chosen name already exists a number will
be added to the end of the name, e.g. PM Usage (1).
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4. CREATING A NEW ACTIVITY
 Select ‘Activity’ from the menu bar.
The activity drop down menu is
displayed. Then select ‘New’ from
this menu.
An alternative way to add a new activity
is to click on the new activity symbol,
, in the toolbar.

The PM will add a new Activity with default values, e.g. the Activity’s name is set to “New
Activitiy”, the deadline is set to “None”, to all views (see Figure 4). The name of the activity in
the tree view will be in edit-mode initially. This means that the name of the activity can be
changed. To select the name in the tree view for editing you need to click once to highlight it
and once more to enter edit-mode.
Several modifications have been made to the different views to produce the diagram shown
as Figure 4. You should try out some of these for yourself and see whether you can recreate
the same look.
The tree view has been shrunk. To do this press the left mouse button between the tree and
list view and drag the mouse to the left. The cursor will change to be two parallel lines with
arrows either side when over the correct part. Similarly by pressing the left mouse button,
between the list and graphic views, and dragging the mouse to the right the list view can be
expanded.
In the list view the columns can be expanded or contracted by pressing the left mouse button
over the dividing lines in the header bar for the columns, again the cursor will change to a
vertical line with arrows either side.
In the graphic view the activity can be moved anywhere. When selected, indicated by the
little selection dots around the edges, press the left mouse button and drag to required
location. It is best to press the button when over the background of the activity rather than
the name.
If the activity is only highlighted a second left mouse button click will put the name of the
activity into edit-mode.
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Figure 4: PM – new activity
 Call the activity ‘Start the PM’ by overwriting the default name.
 By hitting the ‘Enter’ key or by clicking with the mouse on another part of the PM the editmode will be finished and the new name will be displayed in all views.
Note that the changes will be immediately stored in the Proflex Store. The PM Main window
looks something like Figure 5. The columns in the list view can re-ordered by pressing the
left mouse button in the name of the column and dragging it to its new place. Use the scroll
bar to locate the required column.

Figure 5: PM with re-named activity
 Invoke the Activity Form for the ‘Start the PM’ activity by right clicking on the activity in
the tree view (it should have already been selected) and selecting ‘Configure’ from the
context menu.
Invoking the Activity Configuration Form can also be done by selecting the activity in any
view and clicking the ‘Configure’,
button on the toolbar or by selecting the ‘Configure’
menu item from the ‘Activity’ menu. Yet another way to invoke the Activity Form is to doubleclick on the activity in the list view.
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The State of the activity is shown immediately under the tab headings. This activity is Under
Design. The name of the activity is seen in the name field, and this can be changed here, if
required.
 Type in the description of the activity which is only seen by the Manager. Select the text
box to the right of ‘Description’. Type in the description. The Activity Form now looks
something like Figure 6.

Figure 6: Activity Form – Manager tab sheet filled in
The categories and keywords can be set if required but this example is not using them.
Having completed the Manager information one now moves to the Actor information.
 Change to the ‘Actor’ tab sheet by selecting the ‘Actor’ tab.
 Input the Subject by selecting the text box to the right of ‘Subject:’ and typing in the
subject you wish the Actor to see, for example, ‘Start the Proflex Manager’.
 Choose the actor from your Exchange address book. Select the ‘Actor’ button and the
Exchange address book form will open. Select the actor from that dialog.
 Set the Deadline to ‘today’. Use the TAB key to select the whole field and type in ‘today’.
Use the TAB key again to set the date and move on to the importance field. The date
changes to today’s date. Set the importance as required by using the provided menu.
 Write the instructions to the actor in the text box underneath the actor text box.
 Describe the expected results of the activity in the 'Expected Result' area.
The various fields can be set in any order. One only has to click in the required field and
make the necessary change. Equally one can move between tab sheets quite freely to make
changes or review information given.
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The resulting ‘Actor’ sheet will look something like Figure 7.

Figure 7: Activity Form – Actor tab sheet with information
The attachments for an activity need to be added on the Attachments tab sheet.
 Click on the Attachments tab and then drag the attachments, e.g. from an explorer
window, to the area under 'Instructions'. The form should resemble that shown in
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Figure 8: Activity Form - The Attachments tab sheet
 Store the information about this activity in the Proflex Store. This will change the data in
the store. To do this click the ‘Save & Close’ button under the Activity Form's tool bar.
You may get a spelling check at this point. Alternatively you can select “Save” and then
“Close” from the file menu.
The Activity Form closes but unfortunately the new information about the activity is not
shown in the PM Main Window immediately.
 Refresh the PM from the Proflex Store by selecting the ‘Update (current)’ menu item
from the View menu.
The PM list view will now show the Actor information as seen in Figure 9.

Figure 9: PM with one activity selected and configured
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5. SENDING AN ACTIVITY TO THE ACTOR
Now that the Activity is completely designed, send it out to the Actor.
 Select the activity ‘Start the PM’ from the activity list in the PM.
It is highlighted using the default system colours, here they are white text on a navy
background (shown below).
 Open the Context Menu by rightclicking on the list view and then select
‘Send out’.
Alternatively use the send out icon,
the toolbar.

, in

 To update the Task State you must
select the 'Update (current)' option from
the View menu.

The Task State will change to ‘Ready To Send Out’ and a yellow circle appears in front of
the activity name as seen in Figure 10. The yellow circle symbol indicates the state of the
activity although one column also shows the state in English. Typically each state is
represented by a different colour circle. A full description of the symbols can be found in
Proflex V1.3 Reference Manual. Note that once the state has changed it cannot revert to the
‘Under Design’ state again until the Actor has finished with it.

Figure 10: Activity showing ‘Ready to Send Out’ state
If the Background Agent is running then the activity will be forwarded to the named actor in
due course and then the activity when updated will show the ‘Sent Out’ state as seen in
Figure 11.

Figure 11: Activity in ‘Sent Out’ state

Page 11

ESPRIT IV, Proflex
Proflex V1.3 Users' Guide

6. INBOX: WORK ON THE RECEIVED ACTIVITY
 Open MS Outlook and change to the Actor’s Inbox.
The Actor’s Inbox is a sub-folder of the Proflex Intrays folder with the ‘display name’ of the
actor. The view of the Inbox may be different to that shown here as it can be customised per
user or by organisation. This customisation is part of Outlook and is not covered by this
Guide. The basic functions described should still be available but things may look different.
Note that a new message will have appeared in the Inbox (see Figure 12).
Depending on the Background Agent being used the time before the item arrives in the
Inbox can vary. If the Event Background Agent is in use then it should arrive very quickly.
If the ordinary Background Agent is being used then the timer interval set up in the
Background Agent determines when the new message can be expected. From the
ordinary Background Agent you can manually start the forwarding of Activities to the
Inboxes to speed up things.

Figure 12: Inbox with new activity
 Open the new activity by double-clicking on it with the left mouse button.
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This will display the Activity Form with the Actor tab sheet on view (see Figure 13). Note that
this form is similar to that used in the PM but the Manager tab sheet is not displayed. The
sender's name replaces the Actor name. Note that the Task State is shown as Sent Out as
the Activity has been delivered to the Actor’s Inbox. You can read the instructions and
expected results for the activity, as provided by the Manager.
Under the toolbar on the form there are six action buttons, Accept, Start, Complete and
Reject plus Save & Close and Save. These are the actions that are allowed for this activity
whilst it is in its present state.

Figure 13: Activity Form – Actor tab sheet
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 Now change to the Attachments tab sheet and view the attachments. The form
resembles Figure 14.

Figure 14: Activity Form - Attachments tab sheet
When opening an attachment, by double clicking with the left mouse button, the dialog
shown in Figure 15 is usually seen

Figure 15: Opening an attachment
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 Now change to the Results tab sheet. Here you can provide the expected completion
date of the activity, write comments for the Manager and provide the results of the
activity. You can also add personal comments, whilst progressing the activity, to the
Comments (private) field at the bottom of this tab sheet.
The Activity Form now looks similar to Figure 16.

Figure 16: Activity Form – Results tab sheet
Assuming the activity has been completed the actor has no need to go through acceptance,
and starting. The Actor can move directly to Complete.
 Click on the Complete Button below the toolbar.
This will close the Activity Form and remove the Activity from the Inbox.
Depending on the Background Agent being used the removal of the completed activity
can be delayed. With the Event Background Agent the time delay will be very small. With
the ordinary Background Agent the timer interval being used will determine the time delay.
From the ordinary Background Agent you can manually start the synchronisation between
the Inboxes and the activity storage.
 Iconise the Inbox and MS Outlook, by clicking the
window.

button on the top right of the
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7. PM: INSPECT THE PROGRESS
 Update the PM views from the Store. To do this select the ‘Update (current)’ option from
the View menu.
Notice that the change in state is indicated by the green circle in front of the activity name in
the list view. Also the State column shows ‘Completed’ and the Actor Results column shows
the comment provided by the actor.

Figure 17: PM with completed activity
 Review the activity information. Select the “Start the PM” activity and click on the
configure icon,

, in the toolbar

The Activity Form for the selected activity is opened. You will notice that the fields on the first
two tab sheets of the form are grey indicating that they are now read-only. Only the results
field can be extended if necessary. Note that the State field and the Results fields have
changed. Also note that the Comments (private) field is not seen by the Manager.

Figure 18: The Activity Form for a completed activity
 Click the ‘Save & Close’ button to close the Activity Form.
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8. ADDING SUB-ACTIVITIES
To add a new top-level activity you need to ensure there is no selection in the views.
 Click on any tick marks in the tree view to remove the selection or use ctrl/click (i.e. hold
down the control key whilst clicking the left mouse button) to toggle the selection.
 Add a new top level activity by using the ‘New’ option from the Activity menu or the new
activity icon from the toolbar and name it appropriately.
 Select this activity by clicking in the box next to the new activity in the tree view. Ensure
no other activity is selected and add another new activity, which will be a sub-activity, by
using the correct symbol in the toolbar.
The new activity will have as its parent the selected activity and should resemble Figure 19.
By selecting the appropriate parent, sub-activities can be added wherever needed.

Figure 19: Adding a sub-activity
If the new activity has been added in the wrong place then it is very easy to delete it and add
a new one in the correct place. Select the activity to be deleted and click the delete button
in the toolbar, or select 'Delete' from the Edit menu or from the right mouse button
menu. As long as the activity is 'Under design' the activity will be deleted and removed from
the project. Once an activity is 'sent out' it can not be deleted, only marked as cancelled.

9. USING THE GRAPHIC VIEW
The graphic view initially only shows the top-level activities. In our test project there are two
top-level activities, "Start the PM" and "Arrange Demos". To see sub-activities you must
expand the top level activity. Those top-level activities that have sub-activities will display a
small + sign in the box in the top right corner.
 Click on the + sign in the top right corner of the “Arrange Demos” activity in the graphic
view. An expanded box will appear which contains the newest activity, as yet unnamed,
as shown in Figure 20.
The graphic view can be scrolled around using the scroll controls located at the bottom and
on the right hand side. The view area can be increased by shrinking the width of the tree
view and/or the list view.
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Figure 20: An expanded activity in the Graphic View
This new sub-activity can be moved around the expanded box and located where it makes
most sense for the manager. The graphic view can have the activities laid out to represent
time, order, length of activity or any combination. The placement is entirely under the control
of the manager. The expanded box can also be moved around to the desired location. This
is done by pressing the left mouse button when over the background and then dragging to
required location and releasing the mouse button.
 Add one more activity at the top level, two more activities within “Arrange Demos” and
then four activities within one of the sub-activities of “Arrange Demos. With suitable
names, with the expansion of the one containing sub-activities and movement and resizing of the expanded boxes the graphic view should resemble Figure 21.
The expanded boxes can be re-sized. Click on the background of the expanded box and
selection handles (small navy squares or whatever is the default for the system) are seen at
each corner and in the centre of each side. Moving the cursor to any of these and then
pressing and dragging before releasing re-sizes the box.
If whilst moving the activities the display becomes corrupted in any way, closing an
expanded box (by clicking on the “-“ box) and then re-expanding it will usually correct the
corruption.
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Figure 21: Graphic view showing activity hierarchy

10. USING LINKS
When activities have a specific order or relationship, for whatever reason, links can be used
to ensure an activity is not sent out until it is time for it to be actioned. In our simple example
you will see that there are three activities all relating to poster production. Obviously the
production and distribution can not be undertaken until the design process has been
completed. To show this relationship a link can be added between the “Design Posters” and
“Produce Posters” activities, meaning "Design Posters" must complete before "Produce
Posters" may start.
 Select the “Design Posters” activity , which is where the link begins.
 Position cursor over central selection handle and then press (selection handles
disappear) and drag towards “Produce Posters”.
 Release mouse when over “Produce Posters” activity.
A link will be drawn between the two activities. This is shown in Figure 22. The link arrow
shows the direction of the workflow rather than the direction of the dependency.
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Figure 22: A link between two activities
 Insert another link between “Produce Posters” and “Distribute Posters”.
Once these activities have been fully specified, including their actors (which may be
different), all three activities can be sent out. Because of the links only the first activity,
"Design Posters", will actually be sent out to the Actor’s in-tray. The second and third
activities will be placed in a pending state. The effect of the link is that an activity can only be
actually sent out when the activity at the start of the link has been completed.
 Ensure actors have been set on the linked activities and then select all three activities in
the graphic view, using shift + click to add to the selection.
 Click the right mouse button and select “Send out” from the menu.
This is shown in Figure 23.

Figure 23: Multi-selection send out
If a Background Agent, either Event or ordinary in timer mode, is running somewhere then
the activities will be processed. If the ordinary Background Agent is being used without timer
mode then one can use the “Manager Actions” button to force the activities to be processed.
The state of the activities can be seen in the list view.
Figure 24 shows the updated view before the Background Agent has run. The activities are
all in the “ready to send out” state.
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Figure 24: ‘Ready to Send Out’ activities
 Select the 'Update (current)' item from the View menu (once the Background Agent has
down its work).
Figure 25 shows the changes to the state of each activity once the Background Agent has
processed them. As you can see only the “Design Posters” activity has been sent out. The
remaining two activities are now in a Pending state. This means they are pending the
completion of another activity. The actors have not received these pending activities yet.

Figure 25: ‘Pending’ activities
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11. TRIGGERING ANOTHER ACTIVITY TO BE SENT OUT
Once “Design Posters” has been completed the activity “Produce Posters” will be sent out to
the specified Actor.
 Open the inbox for the actor of “Design Posters” and imagine that the job has been
finished. Double click the activity in order to open the Activity Form.


Provide some results and click “Complete”.

The activity will be removed from the inbox as soon as the Background Agent has processed
the change. When an activity is completed any links going from it (those going in the
direction of the arrow on the graphic view) are followed and the resulting, or successor,
activity is checked to see whether it can now be sent out. In our example this will be true as
Produce Posters has just the one link, i.e. only one dependency or predecessor, and that
dependency or predecessor, “Design Posters”, has been completed.
After selecting 'Update (current)' from the View menu in the PM you will see the changes in
state, as shown in Figure 26.

Figure 26: An activity sent out by another activity completing
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12. REFINING THE ACTIVITY BY THE ACTOR
If you open the Inbox for the Actor to whom the “Produce Posters” activity was sent, you
should find it has arrived.
 Double click the activity to open the Activity Form.
On reading the instructions for this activity the Actor realises that it is a big task and decides
to break it down into sub tasks. On the Activity form there is a button labelled “Refine
Activity”, shown in Figure 27.

Figure 27: The “Refine Button” on the AED

 Click on “Refine Activity”.
This initiates the starting of the Proflex Manager with the activity
loaded for refinement, rather than the whole project. The dialog
shown opposite appears in order to confirm the starting of the
PM.
 Click on “OK”.
Once the PM is displayed you will see that the three views are empty and the Project Name
box contains the activity name, see Figure 28. The activity has become the “project” for now
and so the activity name is displayed. This name is not editable as it was set by the Manager
before the activity was sent out. There are no activities on display, as the activity has no
sub-activities as yet. The actor has become the manager for this activity and can now refine
the activity by breaking it down into smaller sub-activities that achieve the goal of the activity
as stated in the Instructions/Expected Result fields of the Activity Form.

Figure 28: The PM with an activity loaded for refinement
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 Click on the “add activity” icon,
A new activity is added, just as it
is a sub-activity of “Produce Posters”.

.
would be to a project at the top level. The activity

 Add two appropriate top level activities and name them, then add sub-activities to the first
and configure them.
 Send out the first activity that needs to be done.
This results in a PM that resembles Figure 29.

Figure 29: An activity refined
Once the refinement of the activity has been completed, for the present, the PM can be
closed as normal.
 Click the “close project” icon,

.

 Select 'Exit' from the Project menu to close the Proflex Manager.
The activity “Produce Posters” should really be accepted and started as work has begun on
the activity.
 Double click the activity in the Inbox again to open the Activity Form and click on “Start”.
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When the Manager next opens (or re-loads) the project the Actor’s refinement will be seen,
see Figure 30. If the PM is still running then the 'Update (reload)' item on the View menu can
be used to ensure the project displays all the activities, including the Actor's new ones.
.

Figure 30: PM showing project with Actor refinement
In the tree view one can see the small + sign next to "Produce Posters" indicating that there
are sub-activities. The list view shows all the activities including the sub-activities within
"Produce Posters". In the graphic view the "Produce Posters" activity has been opened so
that the refinement performed be the Actor can be seen. The symbol, a blue circle, indicating
an activity in progress can be seen in both the list view and the graphic view.
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13. SUSPENDING A PROJECT
During the lifetime of a project it is conceivable that a situation will arise that necessitates all
work on the project being stopped. In our simple example we assume there is some problem
with copyright over the PM and so the demo sessions are in danger. The Manager decides
to suspend all work on the project.
 Select the three top-level activities by using the boxes in the tree view.
 Select 'Suspend' from the Activity menu.
A dialog will pop-up shown
opposite, which asks whether to
suspend all sub-activities as
well.
 Click on the "Yes" button.

The system will now suspend all activities. A backward sloping bar is added across each of
the state symbols in the list view and across the activity boxes in the graphic view, indicating
the suspension (see Figure 31). Suspended activities can not be sent out.

Figure 31: A suspended project
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The Background Agent needs to do some of the suspension work but once this has been
done the Actor's will know about the suspended activities.
Activities that are sent out will show as suspended in the Inboxes of the Actors (see Figure
32) and they will be unable to proceed with the activity. Only results are allowed to be added
to a suspended activity by an Actor.

Figure 32: A suspended activity in an Inbox
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14. RESTARTING A PROJECT
Once the reason behind a suspension has been resolved the project may be able to be restarted. All or a selected few activities can be re-started. In our simple example we will restart all the activities.
 Select the 'Select all' item from the Edit menu.
All activities are selected, so all the boxes on the tree view have their ticks, all rows in the list
view are highlighted and all activity boxes in the graphic view are selected.

Figure 33: All activities selected within a project
 Select the 'Restart' item from the Activity menu.
A question dialog will pop-up
(shown opposite) asking whether
to restart all sub-activities of the
selected activities. As we have
selected all activities we can
answer "No" to this and each
activity will still be re-started.
 Click on "No".
The activities will be re-started, in due course by the Background Agent, and the PM shows
the revised state symbols.
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15. LOADING ANOTHER PROJECT
When work on one project has been completed it can be closed away be selecting the
in the toolbar. If a new project is
‘Close’ option on the Project menu or the close button
selected for loading the existing project will be closed anyway.
 Select the ‘Open’ option on the Project
menu and the list of available projects will
be displayed in a scrolling list. An
example of such a list is shown opposite.
The projects are listed alphabetically.
 Select the required project by clicking
with the left mouse button and the name
is highlighted.
 Click OK and the named project will be
retrieved from the Store and loaded into
the Proflex Manager.
The status bar at the bottom of the Proflex
Manager window displays messages
indicating what is happening until the Project
is displayed.

Once the project has completed the loading,
the Project name is highlighted and no activities are selected. The little plus signs in the tree
view indicate those activities that have sub-activities. The sub-activities can be seen by
clicking on the plus signs. The list view displays all the activities. The graphic view displays
the top level activities and any expanded boxes that were opened when the project was last
closed. Different symbols can be seen by the names of the activities, indicating different
states. No symbol implies “Under Design”, a yellow circle implies “Sent Out”, a blue circle
implies “In Progress”, a green circle implies “Completed” and a red circle implies “Rejected”.
The Proflex Manager with the loaded project is shown in Figure 34.
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Figure 34: A newly loaded project
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16. REVISING A REJECTED ACTIVITY
A rejected activity is highlighted by a red circle symbol. This activity has been rejected by the
Actor for some reason. To review the reason either check the Actor Comment field in the list
view or use the Activity Form by clicking on the Configure button and checking the Results
tab sheet.
For our simple example we will assume that the activity has been sent to the wrong Actor.
The Manager needs to revise the activity.
 Click on the rejected activity in the list view to select it and then select the 'Revise' item
from the Activity menu.
The Activity Form appears and has the same appearance as the standard Activity Form
when configuring an activity, except the only action button is the "Save, Close & Re-send"
one.
 Change to the Actor tab and change the Actor to a more suitable one.
The Activity Form (in Revision 2 mode which is used for rejected and terminated activities) is
shown in Figure 35 below.

Figure 35: The Activity Form in use to revise an activity
 Click on the "Save, Close & Re-send" button.
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The activity is then sent out to the new actor and the PM, after selecting 'Update (current)' on
the View menu, will show this state. Figure 36 shows the activity in the 'Sent Out' state in the
PM.

Figure 36: The updated state of an activity after revision

17. MAKING A SKELETON
If a project contains what is considered to be a useful set of activities they can be selected
and made into a skeleton. A skeleton is a collection of activities, with names, descriptions,
instructions, expected result and other fields which can be included in another project or
used as a basis or starting point for a new project.
Let us assume the project we have in progress currently is thought to be a good basis for
future software upgrade and needs to be made into a skeleton.
If one or more activities are selected then just those activities and their descendants are
made into the skeleton. We will use two of the top level activities.
 Select "Book downtime" and "Install V1.3".
 Select the 'Convert to..' item from the Skeleton menu.
A dialog appears asking for the name of the new
skeleton, shown opposite, which needs to be
completed with a suitable name.
The status bar at the bottom of the PM will inform as
to the progress of the creation of the skeleton. The
current project is not affected by this action.
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18. USING A SKELETON
Skeletons are useful as a starting point for new projects and can be useful in adding in a
certain component, for example "Booking Travel", "Obtaining Quote", required in a project.
We will open a new project and use the skeleton just made as a basis.
 Click the new project button

in the toolbar.

This will close the current project and create a new project.
 Rename the new project as appropriate.
 Select the 'Insert' item from the
Skeleton menu.
A dialog pops up containing the list of
available skeletons. An example of this
dialog is shown opposite. Select the name
of the skeleton required to be inserted into
the new project and then click on the "OK"
button.
The system will then read the skeleton
selected and create new activities within
the new project to match those in the
skeleton.
The status bar at the bottom of the PM
window will display messages to show the
progress of the action.

Once the operation has been completed the PM will resemble the one shown in Figure 37.

Figure 37: A new project with an inserted skeleton
Work can now continue on these activities, changing information, setting actors and sending
out, as would normally be done if the activities had been created from scratch.
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19. RE-PARENTING
Activities that are found to be in the hierarchy at the incorrect place can be re-parented to the
correct place.
With our new project based on the skeleton it may be the case that certain activities are
deemed to be in the wrong place for this specific project. The Manager decides to move the
"Book downtime" activity to be a sub-activity of "Install V1.3"
 Select just the "Book downtime" activity.
 Select the 'Reparent to' item on the Activity menu.
 Select the "Install V1.3" activity by clicking on the name not in the box. Clicking on the
box will add to the selection, whereas clicking on the name will change the selection.
The PM will move the activities and re-display the project. The PM with the moved activity
opened in the tree view now looks like Figure 38.

Figure 38: The PM after a re-parent operation

20. PROFLEX MANAGER: ADVANCED TASKS
This section describes some advanced features available in the PM.
Make the PM look for updates to the Store automatically every 20 seconds by selecting the
‘Update-Timer’ option from the Tools menu. This option will then show a tick mark on the
menu and the project will reload the activities every 20 seconds. This can reduce
performance significantly unless you have the machine power to cope. Selecting this option
again will stop it and the tick mark on the menu will be removed.
The Proflex Manager can be used in stand-alone mode. You copy the projects from the
public Proflex folder store into a Private folder accessible from the machine you wish to have
working in stand-alone mode.
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Appendix 1 – Proflex Glossary
Proflex Term

Definition

Activity

An activity is an aggregate or single item of work, containing a
description of what is to be done and by whom, what results are required
etc. An aggregate activity is usually split into sub-activities.

Actor

An actor is an internal or external person or group of persons like a
department or even possibly a machine (e.g. fax machine) that carries
out activities from a project.

Administrator

The administrator is a person responsible for maintenance of the stored
projects, activities and supporting information which is required for the
Proflex system to run smoothly. They also register users for Proflex.

Attachment

Documents related to a project or an activity are “attached” to the
activity or project. Attachments may be electronic files (MS Word-files,
e-mail files, spreadsheets, etc.) or paper-files.

Cancelled

A project or activity can be cancelled. This action stops any further work
being done on the project or activity. A cancelled project/activity is not
expected to be restarted.

Category

A category is used to classify projects or activities and is used for
managing, finding and monitoring projects and activities. It is a term
describing the kind of project or activity. Examples include “Sales”,
“Motor Goods”, “White Goods”, “Marketing”, “Esprit” etc.

Completion

An activity is completed by entering the results of the ”real” work into
Proflex and signalling that work on the activity has been done to the point
the actor considers complete..

Delegation

Delegation is the action of passing on the work to another but keeping
the responsibility for that work being done.

Design/ re-design

Design and re-design are the processes that allow the continual evolution
of a project, adding, changing and removing activities. A project can be
designed from scratch or by using skeletons.

Enactment

Enactment is the collective term for the different phases within execution
of designed activities: sending out, negotiation, (re-)design, in progress,
completed and monitoring.

Execution

Execution of an activity means carrying out a work item (”real” work)
within or outside of Proflex.

Forwarding

Forwarding is the action of passing on the work to be done and the
responsibility for it to another.

Graphical View

The name given to the display of the project within the Proflex Manager
that shows activities in their hierarchy as boxes of variable size and
location according to the user. Links between activities are also shown.
Typically this view is the right-most view.

Keyword

A keyword is used to classify projects and activities and is used for
managing, finding and monitoring projects and activities. It is a term that
relates to the data within a project, examples include customer name,
part number, part type etc.

Line Manager

A line manager is an actor’s immediate manager and typically relates to
the organisation’s structure rather than the projects undertaken.

List View

The name given to the tabular display showing all the activities within a
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project within the Proflex Manager. Typically it is the central view.

Manager

A manager is a person defining a project or an activity and performing
actions upon the project or activity, e.g. (re-)name, send-out, suspend,
terminate. The manager role is one of the roles the Proflex user may
take on.

Monitoring

Checking the status of work by using standard/user defined reports by
setting filters on project information and visualising them in various ways.

Negotiation

Negotiation within Proflex is about the actor accepting or not accepting
the activity assigned to him. The actor negotiates on the communicated
activity with the manager and may either accept it, delegate/forward it to
another actor or reject it. Negotiation may also involve the line manager.

Organisation’s fields

An organisation’s field on a project or activity is one where the meaning
and the usage are defined by the organisation. They can be used in the
same way as keywords for managing, finding and monitoring.

Parent activity

An activity that encapsulates other activities, i.e. has internal structure
and hence contains sub-activities.

Predecessor activity

Activity preceding another or several other activities.

Proflex User

Anyone who uses the Proflex system is a Proflex user. There are three
main roles that the user can take; manager, actor and viewer.

Project

Projects are a collection of loosely or hierarchical structured activities
guiding a set of business processes that need to be executed to fulfil the
goal of the project.

Project lists

Each project may have lists of people attached to it. Each list is given a
name. These lists can represent different management styles. Examples
include a Steering Group and a Reference Group.

Project team

A team consists of a group of managers and the actors. Each project
team would typically have a project team leader who has overall
responsibility for the project.

Restart

A project or activity that has been suspended may be restarted. This
releases the project or activity so that on it work may continue.

Role

A part played by the user. Each role has a defined set of characteristics.
There are three roles used within Proflex; manager, actor and viewer.

Sending out

The sending out of an activity means communicating to an actor by
various channels that work (described in the activity) has to be done.

Skeleton

A skeleton is a project where all project specific (not generic)
information is removed (i.e. no transactional data), in essence a set of
activities and their structure.

Sub-activity

A sub-activity is one part of a larger (aggregate) activity and so has a
parent activity. There is no difference in designing sub-activities except
that they are on a level lower than their corresponding parent activity All
attributes and the graphical presentation refer as well to a sub-activity.

Successor activity

Activity following another or several other activities.

Suspend

A project or an activity can be suspended. This action stops any further
work being done on the project or activity. A suspended project/activity
may be restarted or terminated.

Terminate

An activity may be terminated by the actor, after acceptance and before
completion. It is used to signify work has been finished on the activity but
the activity as not been completed as expected.
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Tree View

The name given to the display showing a project in its hierarchical
structure with the Proflex Manager. Typically it is the left-most view.

Viewer

The Proflex user acting in the viewer role makes use of the monitoring
facilities provided within Proflex to review the status of work, its planning
and its progress.

Work item

‘Real’ work carried out by an actor. The work item is usually not part of
Proflex. However the results of work items are part of Proflex and they
become attachments.
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